
Display Driver user manuals

Windows 95/98/NT ImageAccel Control Center User Manual●   

OS/2 ImageAccel Control Panel User Manual (ImageAccel 4 only)●   

Application user manuals

Windows 95/98/NT Internet Plug-In for ImageAccel●   

Windows 95/98/NT Demonstration Viewer Software - PVDEMO●   

Windows 95/98/NT Cornerstone Image Viewer●   

ImageAccel Central User Manuals

file:///C|/WINDOWS/Desktop/New Folder/manuals/manuals.htm [2/7/2001 11:53:58 PM]

file:///C|/WINDOWS/Desktop/New Folder/manuals/..\iacentrl.htm


 

User Manual for ImageAccel 4 & ImageAccel 5 Windows
95/98/NT Control Center
ImageAccel Control Center is consisted of an assortment of Applications that can run from the ImageAccel tool bar. This architecture makes it possible for
Cornerstone to enhance the functionality of your display controller by providing you with additional applications. All you need to do to take advantage of a
new application is install it on your hard disk, then restart your system.

Click any of the following links for information about the ImageAccel Control Center and Applications:

 or 
ImageAccel Control
Center

The primary component you use for managing the ImageAccel Control Center and accessing the
available applications.

Quick Display
Resolution

Changes the resolution and color-depth of your desktop.

Pan Control Adjusts the position of your viewport (when you use the viewport feature).

Control Panel/Display Gives you access to the standard Windows Display Properties dialog box, while adding some
additional and very useful features available only with your ImageAccel controller.

Application
Independent Color
Correction

Lets you turn on and off the automatic color correction feature.  It also gives you access to add
and delete programs using this feature and adjust parameters for each application.

Brightness & Contrast
Windows

Gives you access to the use of SmartImage brightness and contrast adjustments. Also provides a
way for you to adjust the image quality in applications that use ScaleToGray for bitonal scanned
images.

BestView BestView improves desktop legibility by providing a set of pre-configured options designed for
high-resolution displays. BestView runs automatically at the end of the setup process, and is
added to the toolbar so you can make changes later.

User Manual for ImageAccel 4 Windows 95/98/NT Control Center
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ImageAccel Control Center
The ImageAccel Control Center installs automatically when you run the Display Driver Setup program provided on your driver disks or ImageAccel Central
CD-ROM. The ImageAccel Control Center provides access to the ImageAccel applications.

The ImageAccel Control Center:

Creates a floating toolbar on your screen●   

Inserts a small icon near the end of the Windows Taskbar (normally appears next to your clock)●   

Adds functions to the menu that pops up when you Right-click anywhere on your desktop.●   

ImageAccel Control Center Toolbar
The ImageAccel Control Center toolbar normally floats above all other applications, so it is always available on your display. The toolbar, however, might
not be visible in the following situations:

The Windows Taskbar covers the ImageAccel Control Center toolbar.●   

You hide the ImageAccel Control Center (to learn how to hide and show the Control Center, see the description of the Hide command).●   

Another application takes precedence, which allows the application's windows to cover the ImageAccel Control Center toolbar.●   

The toolbar uses the minimum amount of space on your screen. You can change the layout of the toolbar by dragging from the edges. In this case, the
toolbar automatically changes its layout to your specified dimensions. Therefore, the toolbar can appear on your screen in many different configurations 
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(ImageAccel 5 Examples) (ImageAccel 4 Examples)

 You can access the ImageAccel Control Center Main Menu and all of the available applications by clicking one of the toolbar buttons. The buttons
represent (from left-to-right, top-to-bottom): the ImageAccel Control Center Main Menu, Quick Display Resolution application, Pan Control application,
Display Properties application, Application Independent Color Correction application,  ImageAccel Smart Image application, and Best View
application.

ImageAccel Task Bar Button
Right-click the ImageAccel Taskbar button (near the end of the Windows Taskbar) to display the popup menu for access to your ImageAccel Control Center
software. This method is an alternative to using the ImageAccel Control Center Main Menu, as described later in this section.
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Desktop Popup Menu
Right-click in an open area of your desktop and the following popup menu appears.
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(ImageAccel 5 image)      (ImageAccel 4 image)     

The Desktop Size and Viewport Size options are the same as those provided in the Quick Display Resolution application (Note: Viewport option is only
available for ImageAccel 4). 

Note:  The Desktop Popup Sizing options are not available with Windows 98 or when using Internet Explorer 4.

ImageAccel Control Center Main Menu
To access the Main Menu, click the ImageAccel Control Center button on the toolbar, or Right-click the ImageAccel Taskbar button near the end of the
Windows Taskbar (as described above). The Main Menu provides functions for Auto Hide, Docking, and Exiting from the ImageAccel Control Center
software. 

Windows 95/NT 4.0 User Manual - Control Center
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Auto Hide

This option provides the same basic functionality as the Windows Taskbar. The ImageAccel Control Center toolbar hides itself automatically when not in
use. You can unhide the toolbar by pointing your cursor to the location on your screen where it normally appears. For example, if the toolbar normally
appears at the top of your display, move your cursor to the top edge of your screen (near the center) and the toolbar drops down from the top. When you
move the cursor away from the toolbar, it again goes into hiding.

The Auto Hide option is a toggle-type command. You can alternately select and deselect it by choosing it from the Main Menu. A check mark appears next
to the item when the option is active; when the option is inactive, the check mark is not present.

Only one component can make use of the Auto Hide function at the same screen location at any given time. That is, if you set the ImageAccel Control
Center toolbar to dock at the bottom of your screen (docking is discussed later in this section) and you also position the Windows Taskbar at the bottom of
your screen, only one of the components may use the Auto Hide function. If, however, you dock the two components at different screen locations (such as
one at the top and one at the bottom), you can Auto Hide both components.

Hide

Immediately hides the ImageAccel Control Center toolbar. To show the toolbar again after hiding it, right-click the ImageAccel Taskbar button near the end
of your Windows Taskbar and choose Hide from the popup menu; or, double-click the ImageAccel Taskbar button.

Windows 95/NT 4.0 User Manual - Control Center
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Float and Docking Options

Use the docking options (Dock to the Left, ... Top, ... Right, and ... Bottom) to specify the location on your screen where you want the toolbar to reside.
Choose the docking location you want from the Main Menu and the toolbar immediately moves to that location.

In addition to docking, you can Float the toolbar on your screen by choosing this option from the Main Menu. In this state, you can move the toolbar to any
location by dragging it by its title bar.

Exit

Terminates the ImageAccel Control Center software. This option removes the toolbar from your screen. To return the toolbar, you must restart the
ImageAccel Control Center. You can access the ImageAccel Control Center using your Start menu.

NOTE: When you use the Exit command, you automatically disable the ImageAccel hot keys feature. You will not be able to use hot keys for such functions
as Zoom In, Zoom Out, Pan, and so forth. See Hot Keys for more information.
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Quick Display Resolution Application
Quick Display Resolution is an ImageAccel Application. It is included with the default application set and installs automatically when you run the Display
Driver Setup program from your driver disks or ImageAccel Central CDROM.

Use Quick Display Resolution to quickly change the resolution (or, desktop size), and color-depth of your desktop.

Click the Quick Display Resolution button on the toolbar to access the application.. A menu appears giving you access to two options—Desktop Size and
Viewport Size (Viewport only available for ImageAccel 4 controllers). Each of these options displays a submenu with the available resolution options.

Desktop Size
The submenu that appears when you highlight the Desktop Size option shows the various desktop resolutions and associated color-depths available with
your ImageAccel display driver software.

Windows 95/NT 4.0 User Manual - Quick Display Resolution
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(ImageAccel 4 image) (ImageAccel 5 image)

                            

                                                                                                                                                       

Each option in the submenu shows the available color-depth (such as 256 Colors, 64K Colors, or 16.7M Colors) and the horizontal and vertical resolutions
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available for each color-depth choice. For example, if you choose 64K Colors 1280x1024, your display operates at 64,000 colors (High Color) at a
horizontal resolution of 1,280 pixels and a vertical resolution of 1,024 pixels.  For ImageAccel 5 controllers, additional "32 bit" color depth options are
available.

When you select a different desktop size, your display goes blank for a moment before implementing the change. This is normal.

NOTE: Some Windows applications do not respond correctly to "on-the-fly" changes in resolution and color depth. If one of your applications appears to
respond incorrectly to your changes, try setting your display back to the default (normally 256x1600x1200). If the problem persists, contact the application
developer for assistance.

Viewport Size (ImageAccel 4 only)
The Viewport is a moveable window through which you can view any portion of your virtual desktop when your desktop is larger than your display screen.

Select the size of viewport you want from the Viewport Size submenu.

Windows 95/NT 4.0 User Manual - Quick Display Resolution

file:///C|/WINDOWS/Desktop/New Folder/manuals/m95_qdr.htm (3 of 4) [2/7/2001 11:54:11 PM]



Your current viewport is always the same size as or smaller than your current desktop. The Viewport Size submenu shows the available viewport sizes.
Choose the viewport size you want from the submenu. The change in viewport size takes place immediately.

When you select a viewport size that is smaller than your virtual desktop, your viewport resolution automatically changes to the specified resolution. The
image inside your viewport increases in size—as though magnified. This does not affect the size of your desktop, only the size of the area that you are able
to see through your viewport.

While using the viewport, move the cursor to any edge of the viewport window and the window moves automatically in that direction, showing you other
areas of your desktop.
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Pan Control Application ImageAccel 4
Pan Control is an ImageAccel application. It is included with the default application set and installs automatically when you run the Display Driver Setup
program from your driver disks or ImageAccel Central CD-ROM.

Use Pan Control to move (or, pan) your viewport of the desktop to a specific location. Pan Control works in conjunction with the Viewport Size option
which is available in the Quick Display Resolution application. The Pan Control feature is active only when your current Viewport Size is smaller than the
size of your virtual desktop.

To access Pan Control, click its button on the ImageAccel Control Center toolbar. A small window appears at the center of your desktop showing a
miniature view of your desktop. At the center of the Pan Control window is the Pan Control Frame.

The following buttons appear at the bottom of the Pan Control window:

Desktop—Indicates the current size of your virtual desktop (such as 1280x1024)

Viewport—Indicates the current size of your viewport (such as 800x600)

Click the Desktop or Viewport button to change your current desktop or viewport. These buttons provide the same functionality found in the Quick Display
Resolution application. When you use this feature, your display screen momentarily goes black before resetting itself to your chosen resolution. This is

Windows 95/NT 4.0 User Manual - Pan Control Application
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normal behavior.

If your current viewport size is smaller than your current desktop size, the Pan Control Frame is visible inside the Pan Control window. If the viewport
size is equal to or larger than the desktop size, the Pan Control Frame fills the entire Pan Control window, so panning is not available.

While the Pan Control Frame is visible in the Pan Control Window, you can drag it to different locations to change the position of your current viewport.
When you move the cursor inside the Pan Control Frame and click and hold the mouse button, the cursor changes to a four-headed arrow. Hold down the
mouse button and drag the Pan Control Frame. When the area you want to set as your new viewport appears inside the Pan Control Frame, release the
mouse button. You can then click the close box in the Pan Control Window to remove it from your screen.

Remember, whenever your viewport is smaller than your virtual desktop, you can automatically pan the viewport over the desktop just by moving the
cursor to the edge of your screen.

NOTES: If you move windows or icons on your desktop after activating the Pan Control application, you will have to close and re-activate Pan Control to
see your changes. That is, the Pan Control window does not reflect your changes until you close and re-open it.

If the Pan Control window is open, and your viewport is smaller than your desktop, the Pan Control window automatically sets itself at the center of your
viewport. That is, if you move the cursor to the edge of your display to pan your viewport while the Pan Control window is open, the Pan Control window
adjusts itself automatically so that it remains in the center of your viewport. You cannot change the Pan Control window's position.

 

Pan Control Application ImageAccel 5
Pan Control is an ImageAccel application. It is included with the default application set and installs automatically when you run the Display Driver Setup
program from your driver disks or ImageAccel Central CD-ROM.

Use Pan Control to move (or, pan) your viewport of the desktop to a specific location.   The Pan Control feature is active only when your current Viewport
Size is smaller than the size of your virtual desktop.

To access Pan Control, click its button on the ImageAccel Control Center toolbar.  A small window appears at the center of your desktop showing a
miniature view of your desktop
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Four buttons Appear at the top of the Pan Control window: Zoom-in, Zoom-out, Pan lock, and CenterWINDOW.

Zoom-in - Allows you to magnify the viewport of the desktop.  You can scroll by moving your mouse to the edge of the viewport in the preferred scrolling
direction and the viewport will scroll to the edge of the virtual desktop. Zoom-in has two magnification settings.

Zoom-out - Allows you to retract the magnification steps initiated with Zoom-in.  Zoom-out can not exceed the virtual desktop resolution setting.

PanLock - At the highest magnification setting PanLock activation does not allow the viewport to pan freely.  

CenterWINDOW - In a zoom-in mode, CenterWINDOW allows you to pick a application (open applications that are not minimized are listed when this
button is activated) to center the viewport over. 

If your current viewport size is smaller than your current desktop size, the Pan Control Frame is visible inside the Pan Control window. If the viewport
size is equal to or larger than the desktop size, the Pan Control Frame fills the entire Pan Control window, so panning is not available.

Remember, whenever your viewport is smaller than your virtual desktop, you can automatically pan the viewport over the desktop just by moving the
cursor to the edge of your screen.

If the Pan Control window is open, and your viewport is smaller than your desktop, the Pan Control window automatically sets itself at the center of your
viewport. That is, if you move the cursor to the edge of your display to pan your viewport while the Pan Control window is open, the Pan Control window
adjusts itself automatically so that it remains in the center of your viewport. You cannot change the Pan Control window's position.
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Display Properties Application
Display Properties is an ImageAccel control center application. It is included with the default application set—so it installs automatically when you install the
ImageAccel Display Driver.

Display Properties provides the same basic functions as the Windows Display Control Panel (that is, the Display Properties dialog box), but adds new functions to give
you more control of your display operations.

Click the fourth button on the ImageAccel Control Center toolbar to access Display Properties.  The Display Properties dialog box is different between ImageAccel 4
and ImageAccel 5.  ImageAccel 4 uses the generic Microsoft Display Properties dialog box with three additional new tabs, ImageAccel 4, Refresh Rate and Hot
Keys.  ImageAccel 5 has its own customized Display Properties page shown below.  It also adds a new tab, ImageAccel 5, to the Microsoft Display Properties page. 

NOTE:  The Refresh Rate page for ImageAccel 4 will NOT appear if you specify a Cornerstone Color 20/70 or 21/76 fixed frequency display. The Display Properties
application also adds one additional feature to the Settings panel, which you can read about in the next section.

Under Windows 98 the Cornerstone tabs are located in the display section under Microsoft "Settings" page.  You may access the display section by clicking on the
"Advanced" button on the "Settings" page.

Settings Panel for Windows 95
For ImageAccel 4 controllers, the Display Properties application adds the Viewport area controls to the Settings panel in the Display Properties dialog box.   You can
use the Viewport area control to specify the size of the viewport window you want to use. This function is the same as choosing an option from the Viewport Size
submenu in the Quick Display Resolution application. See the description of that application for details.
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Settings Panel for Windows 98
For ImageAccel 4 controllers the "Advanced" button on the Settings Panel lets you get into all the ImageAccel Panels.  For ImageAccel 5 controllers, the Settings Panel
can only be reached by clicking the "Control Panel/Display" button on the ImageAccel Control Center toolbar.
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ImageAccel 4 and ImageAccel 5 Panel
The panel shows information about your display, display controller card, and the version of the BIOS you are using. This is for informational purposes—you cannot
change the information. This information is useful if you need to contact our Technical Support department.  This section also shows technical details about the
software display driver you are using. This information is useful if you need to contact our Technical Support department and they advise you to check the current
revision number for your display. This too is for information purposes only—you cannot change the information.

(ImageAccel 4 Image)             (ImageAccel 5 Image)
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Cursor Color (ImageAccel 4 only)

If you want your cursor to appear in some color other than standard yellow, choose the color you want from the drop list. The arrow inside the box shows the currently
selected color.

 

Read Me Button

Click to display the Read Me document ( I4README.TXT for ImageAccel 4 controllers and I5README.TXT for ImageAccel 5 controllers) containing special notes
and last minute information about your controller, and your ImageAccel software. Normally, this document opens with the Windows Notepad application.

Contact Information Button

Click to display a dialog box containing information about how to contact various departments within Cornerstone Peripherals Technology.

Hot Keys Panel
You can use this panel to assign or unassign keyboard keys to various ImageAccel functions. In order for the hot keys to function, the ImageAccel Control Center must
be running on your system.
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ImageAccel 4 Hot Keys
This list shows the current state of hot key assignments. It lists each Hot Key, the Action assigned to that hot key, and indicates whether or not the Hot Key is Disabled.

Action List (ImageAccel 4 only)

This drop list shows all of the available ImageAccel Control Center functions that you can assign to hot keys.

Zoom In—Enlarges the display by one viewport level each time you press the assigned hot key. With each press, the display goes momentarily blank, then positions
itself so that the cursor is in the approximate center of the display screen. Different displays support different levels of zooming. If pressing the Zoom In hot key does
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not change the image, you have reached the maximum zoom level. The default hot key for this action is Ctrl+F12.

Zoom Out—Reduces the display by one viewport level each time you press the assigned hot key. With each press, the display goes momentarily blank, then positions
itself so that the cursor is in the approximate center of the display screen. You cannot zoom out to a level that is greater than the current desktop size, as specified with
the Quick Display Resolution application. The default hot key for this action is Ctrl+F11.

Zoom Restore—Alternately switches between the viewport size selected in the Quick Display Resolution application and the currently selected zoom level with each
press of the assigned hot key. The default hot key for this action is Ctrl+F10.

Pan Lock—Locks the viewport at the current position on your desktop. When the viewport is locked, it does not move (or, pan) when you move the mouse pointer.
Press the hot key again to unlock the viewport. The default hot key for this action is Ctrl+F9.

Show/Hide Pan Control—Alternately shows and hides the Pan Control window. This is the same functionality provided by the Pan Control Application. See the
application description for detailed information. The default hot key for this action is Ctrl+F8.

Quick Resolution—This defines a key stroke to activate the Quick Resolution selection in the ImageAccel Control Center.  The default hot key for this action is
Ctrl+Shft+F7.

Show/Hide Pan Control—This defines a key stroke to activate the Brightness and Contrast adjustment control in the ImageAccel Control Center.   The default hot
key for this action is Ctrl+Shft+F5.

Hot Key

Shows the hot key currently assigned to the function shown in the Action drop list. Normally, you can use the default hot keys assigned to the various actions. You
might need to assign different hot keys if the defaults conflict with hot keys assigned in other applications that you use.  For ImageAccel 5, the hot key associated with
a function is listed in the window next to the Hot Key summary.

Working with Hot Keys

The following sections explain how to add, modify, and remove hot key assignments. Note that when entering a key combination you want to assign to an action, you
must hold down the first key (such as Shift) while typing the second key (such as F8). You subsequently use this same key combination when activating the action
with the hot key.

To assign a hot key to an action (ImageAccel 4 only):

Select the action you want from the Action drop list.

Click in the Hot Key text box, then press the key or keys you want to assign to the selected action.

Click the Modify button.

To remove an assigned hot key (ImageAccel 4 only):

Click the hot key you want to remove in the Hot Key column of the ImageAccel Hot Keys list.

Click the Remove button.

To assign a different hot key to an existing action:
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Select the item you want to change in the ImageAccel Hot Keys list.

Click in the Hot Key text box to insert the text cursor.

Press the key or keys you want to assign to the selected item.

Click the Modify button.

To add a new item to the Hot Keys list (ImageAccel 4 only):

You can add a new item only when there is not currently an entry in the ImageAccel Hot Keys list for that action. If the action already exists in the list, use the modify
procedure to assign a different hot key.

Select the action to which you want to assign a hot key in the Action drop list.

Click in the Hot Key text box to insert the text cursor.

Press the key or keys you want to assign to the action.

Click the Add button.

To disable a hot key assignment (ImageAccel 4 only):

Select the hot key assignment you want to disable in the Hot Key column of the ImageAccel Hot Keys list.

Select the Disable check box.

ImageAccel 5 Hot Keys
ImageAccel 5 has hot key selections for six pre-selected functions only.  They are CenterWindow, MaxView, PanEnd, PanHome, PanLock, and PixelTouch.  They
have no hot key assigned to them by default.  To assign a hot key to any one of the function above, just click the function selection in the list box shown above.  As the
function is selected, you will see an input box appears on the right side blank area.   Underneath the input box, you will see a brief explanation for the function.   To
enter the hot key, select the input box (which should default to NONE at this point), and enter the hot key you wish to activate (e.g. Alt F9).  After you press Alt + F9,
you will see it displayed in the input box.  If you are satisfy with the selection, press OK button to activate the hot key.

The Display Scheme is currently not available for ImageAccel 5.  This feature will be available on the later release of  ImageAccel 5 display software.

ImageAccel 4 Refresh Rate Panel
If you are using a display not manufactured by Cornerstone, you might need to adjust the refresh rate for your display for best image quality.

You can use this panel to set your display's refresh rate (that is, the frequency with which the display redraws the image on the screen) for all of the various resolutions.
Normally, you will want to set the refresh rate as high as possible for optimum performance. However, if your display seems to  jitter, try setting the refresh rate lower.

CAUTION: Refer to your display's owner manual before changing its refresh rate. DAMAGE CAN RESULT if you use refresh rates that are too fast for your
display.
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Current Resolution

This part of the panel shows the resolution you have currently selected (in the preceding example, it is 1024x768). The position of the knob shows the current refresh
rate for this resolution. The current refresh rate also appears just below the slider (in the above example, the current refresh rate is 70 Hz).

Drag the slider knob to a different position to change the refresh rate for the current resolution.

Other Resolutions

This part of the panel shows the current refresh rate for all of the other resolutions from which you can select. You can change the refresh rate for any of these other
resolutions the same way that you change it for the Current Resolution (see above).
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Test Button

Note the small, red and green arrows immediately above each slider. Green indicates that your display has been tested for that particular refresh rate at the specified
resolution. Red indicates that your display has not been tested at that refresh rate.

You can test your display for the refresh rate at the Current Resolution by clicking the Test button near the bottom of the panel. While performing the test, watch your
display closely. If the image appears to flicker or jitter, that particular refresh rate at the selected resolution is probably one you should avoid using. On the other hand,
if the image appears to be stable, the refresh rate is suitable.

NOTE: This testing procedure is strictly subjective. That is, your display cannot pass or fail a test. It is up to you to determine whether or not your display performs
satisfactorily at any given refresh rate simply by observing the display's performance while conducting a test.

ImageAccel 5 Monitor Panel
The ImageAccel 5 Monitor Panel allow you to fine tune your display by adjusting the monitor's refresh rates, front and back porch settings, and synchronization.  Since
ImageAccel 5 already provided the most optimal settings for Cornerstone display monitors, we strongly recommend that you DO NOT use this feature on Cornerstone
displays.  If you are using a display not manufactured by Cornerstone, you might need to adjust the refresh rate for your display for best image quality.  However, we
recommend that you familiar yourself with the technical details of your monitors before using this panel. 

CAUTION: Refer to your display's owner manual before changing its refresh rate. DAMAGE CAN RESULT if you use refresh rates that are too fast for your
display.
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Selecting Monitor Type Selecting Resolution

  

You start adjusting the monitor by selecting a monitor type which resembles closest to the capability of your monitor(see above left).  Let's us select VESA 1600x1200
@60-85Hz as an example to demonstrate this process.  After selecting the monitor type, press the "Properties.." button to see all the resolution available for the
monitor type.  You need to go through each resolution in order to properly configure all the video timing information (see above right).   After you select a resolution,
press the "Test..." button to view the current setting.  You will receive a warning message about resolution change and a prompt about editing the current video timing
information.   If you want to change the current video timing, press Yes to go through the adjustment selections.  Again, you will receive another warning message
about the danger of customizing video timing and how to use "Escape" key to get out of bad settings. 

At this point, you will see a simple dialog for adjusting refresh rate, screen dimension, and display position.  You may use these controls to establish your new video
timing for the selected resolution.  Or you may press the "Details>>" button to enter the Pixel Clock, Refresh Rate, Front Porch, Back Porch, and sync information for
both vertical or horizontal signals.  Again, we recommend that you familiarize yourself with your monitor technical specification before attempting this process.

Windows 95/NT 4.0 User Manual - Display Properties
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ImageAccel 5 Color Panel
The ImageAccel 5 Color Panel allow you to establish the default gamma setting for your desktop.  This new setting will be the default configuration for the Application
Independent Color Correction adjustment panel.

ImageAccel 5 Settings
The ImageAccel 5 Settings is similar in functionality with Microsoft Display Panel Settings.  It allow your to change Display resolution, Display Color Depth, and
Font Size.  You can also create your own configuration with Display Scheme selection.   This panel also has an "Advanced.." for turning on and off display
performance and display utility features.

ImageAccel 5 Information
The ImageAccel 5 Information Panel provides graphic chip information from our vendor, Matrox Graphic Inc.  Our technical Support group may need this information
when you encounter display anomalies.
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Application Independent Color Correction
Application Independent Color Correction is an application for you to fine tune the color effect for various programs.  It is an expansion of Image control
center into color images.

Application Independent Color Correction lets you adjust gamma color, temperature, brightness and contrast parameters of different applications.  You can
pick a set of preconfigured settings, or you can customize your own.  After you add an application to Application Independent Color Correction, the screen
will automatically adjust to the values you set when the focus is on the window of that application, provided that Image control center is up, and this option
is turned on.

Application Independent Color Correction is part of ImageAccel control center, and it is installed when you install the driver.

Adjustment of Colors

You can access Application Independent Color Correction two ways.

First, you can access it through ImageAccel control center.  After clicking its button on the ImageAccel Control Center toolbar, the menu below will appear.

The first item lets you turn on and off the ability to automatically adjust colors.   If you click on the second item, the Color adjustment wizard will pop up on
the screen.

Automatic Color Adjustment for ImageAccel4
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The list box in the wizard display the applications that have been set up for color adjustment, the setting they would be adjust to, and the location of the
executable program.  From this wizard, you can add or remove a program, or you can change a program's current setting.  If you select an application, then

Automatic Color Adjustment for ImageAccel4
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click "Change" from this dialog, or if you double click at an app (which means edit the setting of the app), or if you select "Add", then choose an executable,
you will get the following dialog.

Automatic Color Adjustment for ImageAccel4
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If you just added a new app, it will have selected the "Disabled" setting.   You can choose a preconfigured setting, or you can choose "Custom...".   Once
you choose custom, the "Finish" button on the bottom will change to "Next".  You will further specify your parameters by selecting "Next".

Automatic Color Adjustment for ImageAccel4

file:///C|/WINDOWS/Desktop/New Folder/manuals/m95_col.htm (4 of 5) [2/7/2001 11:54:45 PM]



You can utilize the sliders or the edit boxes next to them to set up your values.   The screen will change according to your value so that you will see what it
will be like.  You can save the settings by clicking at the "Save" button, and give the setting a name.  You can also select other settings that have been
defined by choosing the name of setting at the combo box.  You can restore the settings to what they were before you change them, or default them.  The
default values on all of the indicator is 50, out of 100.  Once you select "Finish" at the bottom, the values are saved.

Another way to get to the Color Adjustment Wizard is to right click at an application.   The application can be listed at the explorer, or under the start menu
on Windows 98.  Choose the "Auto Adjust Color" entry from the menu that appears after you right click your mouse on the app, then the Color Adjustment
Wizard will pop up.

 

Automatic Color Adjustment for ImageAccel4
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Instant Brightness and Contrast
Windows Application
Instant Brightness and Contrast (IBC) application is an ImageAccel Control Center application. It is included with the default application set—so it installs
automatically when you run the Display Driver Setup program from your driver disks or ImageAccel Central CD-ROM.

The IBC application provides optimum image quality for scanned images and any image that uses the gray scale color palette with qualified applications. 
The IBC application uses proprietary algorithms that produce gray-scale image quality that no other application or utility program can match.

What is a Qualified Application? A qualified application is one that uses the Cornerstone ScaleToGray technology. Many software application developers
use this technology to ensure that their applications produce the highest possible quality in gray scale images.

To start the IBC application, click its button on the ImageAccel Control Center toolbar.  If no qualified applications are running when you start the IBC
application, the following dialog will appear:      

                        

 

If a qualified application is running, the following dialog box appears (shown with the <<Advanced option clicked). Use this dialog box to adjust the Scale
To Gray for the image that currently has the focus. Note that the qualified application name and image file are listed in the title bar of the dialog box.
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Adjusting the Palette
The IBC application provides a function for adjusting the current palette for the current image window of the qualified application.  By making these types
of adjustments, you can significantly increase the readability and quality of most images.

To adjust the palette:

Click the Adjust Palette button in the IBC application. The following dialog box appears.
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Move the vertical slider up or down to adjust the image's Contrast. Move the horizontal slider left or right to adjust the image's Brightness.

Note that when you move the sliders, the Palette bar normally shifts its spectrum to reflect how your adjustments affect the current palette.

If you want to be able to observe the effects of your adjustments on the image in the qualified application window, select the Instant Update option.

The Save options allow you to pre-set Brightness and Contrast settings for different types of documents.

The Smart button, when clicked, optimizes the palette for the current window. The IBC application analyzes the data in the window and creates a palette
the makes the best use of the colors in the window.

When the image looks the way you want, click OK. Note: It's not possible to save the image in your qualified application to make your changes permanent,
you have to adjust the image whenever you reload it.
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Advanced Functions
The IBC application provides some advanced functions to help you control images.

To access the advanced functions, click the Advanced>> button in the IBC application. The application window expands as shown here.

All of the options in the Advanced section pertain to color palette functions.
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Manual Adjust

This option, when selected, instructs the current window to use its own, individual palette.

Auto Smart Palette

This option is similar to the Smart button in the Brightness & Contrast dialog box described earlier (see Adjusting the Palette). It optimizes the palette for
the current window.  The IBC application analyzes the data in the window and creates a palette the makes the best use of the colors in the window.

Set this mode as Default

Select this option to make the current Palette Mode option the default.

Save

Set from one to four Save options to create your own presets.

NOTES:
Instant Brightness and Contrast can only operate on one image at a time, on the image with focus.●   

If Scale to Gray is turned off on the focused image, then the Instant Brightness and Contrast control will unload itself.●   
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BestView Application
BestView improves desktop legibility by providing a set of pre-configured desktop settings (font size, icon size, spacing, etc.) designed specifically for
high-resolution monitors. Selecting the recommended 'Best View' will result in larger desktop objects that will be easier to read while running in
high-resolution.

BestView runs automatically at the end of the display driver setup process, providing you the option to use the recommended settings or the VGA standard.
BestView is added to the ImageAccel Control Center toolbar so you can make changes later. BestView does not change any other customized user
appearance settings, such as desktop color schemes or font styles.

Apply

BestView offers the following recommended settings, which are based on the size of your display or resolution:

Optimized for 1280x1024 res. (17" monitor) - M

Optimized for 1600x1200 res. (19/20/21" monitor) - L

Optimized for 1856x1392 or higher res. (21" monitor) - XL

Windows Standard Desktop

You may select the recommended setting for the display or resolution you have, or you may select ANY of the options listed, regardless of the display you
have. Click on the Apply button to see the result of your selection, and the desktop changes instantly.

NOTE: If you choose a setting with large icons, you should perform the Arrange Icons desktop function to update your screen. To Arrange your desktop
icons:

Find a clear space on your desktop, and right click.●   

Select Arrange Icons.●   

Select to arrange by Name, Type, Size, Date, or Auto Arrange.●   

If you don't like the current setting, you may open the BestView icon on the ImageAccel Control Center toolbar: , and select another option.

Selecting the Windows Standard Desktop will give you the Microsoft default sizes for font size, spacing, and icons used for standard VGA (designed for
screen resolution of 640 x 480). Selecting the Windows Standard Desktop while running in high-resolution will make the desktop items appear small and

BestView for ImageAccel 4
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will be harder to read.

Advanced

Selecting the Advanced option opens the standard Windows Control panel Appearance tab.   Here, the Scheme is loaded with the current desktop settings.
This Appearance interface allows you to customize your settings further using the standard Windows interface provided by the operating system. If you
have modified these settings, you may save them using the Save As button. Note that any customized settings you create this way will NOT appear in the
BestView option dialog box.

BestView for ImageAccel 4
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User Manual for ImageAccel 4 OS/2 Control Panel
Table of Contents

Information Notebook Page●   

Display Settings Notebook Page●   

Desktop Options●   

Color Depth●   

Uninstall●   

Cornerstone Contact Information●   

Resource Options●   

Windows Options●   

Zoom and Pan Notebook Page●   

Power Save Notebook Page●   

After you install the ImageAccel 4 Display Driver for the first time, the ImageAccel Control Panel notebook will run automatically. Some notebook pages
include the buttons Default and Undo. These buttons affect only the settings on that page. Selecting the Default button returns the values on that page back to
the factory defaults. Selecting the Undo button returns your previous values for that page.

Some features provided with the ImageAccel Control Panel may not be supported for particular releases. In this case the feature is grayed out and is not
accessible.

After you make your changes, shutdown and restart your system for the new settings to take effect. On subsequent restarts, the ImageAccel Control Panel will
be found in the ImageAccel 4 display driver folder installed on your desktop.

NOTE: Some programs have problems with large resources such as large cursor & system fonts, or large icons. If your application exhibits such problems,
switch back to the default settings using the ImageAccel control panel.

The ImageAccel Control Panel works just like any other OS/2 notebook, in that it saves your changes each time you turn a page. Note however, that many
changes do not go into effect until the shutdown and restart is completed.

Top
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Information Notebook Page

This page gets information from your installed ImageAccel hardware and software to aid in troubleshooting. The following information is displayed;

Hardware:Controller, Board Type, Resolution and Monitor Code.

Display Driver: Version, Build Rev, Build Date, Memory Address and IO Address.

On this notebook page, clicking the button marked README displays the I4README.TXT file in an editor window. This file contains important installation
and configuration information. We recommend that you read this file before completing the ImageAccel 4 installation.

Top
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Display Settings Notebook Page

Display Settings has three category tabs located at the bottom left corner of the notebook (near the 'binder'). When you first click this tab, you'll be in the
Desktop category. This category provides settings to be used for all display environments - PMSHELL, WIN-OS/2 Full Screen, and WIN-OS/2 Seamless
modes. The settings on this page are not individually configurable for these three display environments.

Top

Desktop Options

Desktop Size:
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The Desktop Size option selects the virtual desktop size which varies for each controller and display type. Choices may range from:

1800 x 1440●   

1600 x 1280●   

1600 x 1200●   

1280 x 1024●   

1024 x 768●   

800 x 600●   

640 x 480●   

Changing the Desktop Size option does not change the appearance of the display.

Viewport Size:

The Viewport Size option selects the resolution that is actually displayed on the monitor. For example, choosing 1280 x 1024 displays 1280 pixels horizontally
and 1024 scan lines vertically:

1800 x 1440●   

1600 x 1280●   

1600 x 1200●   

1280 x 1024●   

1024 x 768●   

800 x 600●   

640 x 480●   

With a Viewport Size smaller than the Desktop Size, only a portion of the full OS/2 or WIN-OS/2 desktop will display. Dragging the mouse to the edge of the
screen moves the Viewport in that direction, and exposes the remainder of the desktop.

Viewport Change on the Fly:

The Viewport Size can be changed on the fly by moving the slider bar to the correct resolution and then clicking on the Apply button.

NOTE: Closing the ImageAccel 4 Control Panel without clicking the Apply button will prompt you to shut down and reboot.

Top

Color Depth

The Color Depth option allows to choose the Color Palette, and switch between the default 256 colors (8 bit), 64K colors (16 bit), and 16.7M colors (24 bit)

Top

Uninstall
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The Uninstall button can used to remove the Cornerstone ImageAccel 4 Display Drivers and revert your system back to VGA. The Uninstall button can be
found on the Display Settings page of the ImageAccel 4 Control Panel.

Cornerstone Contact Information

Contact information is accessed in the ImageAccel 4 Control Panel from the Information page.

Top

Resource Options

Icon Size & Cursor Size:

The Icon Size and Cursor Size options select the size of system PMSHELL and WIN-OS/2 icons and cursors. Icon and cursor sizes can be set differently. The
size is not dependent on the Logical DPI.

For both Icon and Cursor the choices are:

Standard (default)●   

Large●   

Font DPI & Dialog Box DPI:

This option allows to change Font and Dialog Box DPI.

The choices for Font DPI are:

96●   

120 (default)●   

150●   

For Dialog Box DPI:

96●   

120 (default)●   

PPM Setting:

PPM is OS/2's Pixel Per Meter Setting. With this feature, both Horizontal and Vertical logical PPM counts used by OS/2, WIN-OS/2, and Document Imaging
applications can be changed. ImageAccel 4 gives you flexibility to choose settings -- from 50% up to 150% -- from the defaults listed in Default Horizontal and
Default Vertical. For OS/2, the DPI (Dots Per Inch) shown is a conversion of the Pixel Per Meter setting (PPM).

To adjust the default image size - click on percent (%) scroll bar. The PPM & DPI values will automatically adjust. This Logical DPI count is also used to
determine the size of many elements such as rulers and scaleable fonts. The larger the logical DPI, the larger the size of these elements. Since every application
uses this PPM/DPI slightly differently, when you change the Logical DPI, some application elements may change size and some may not.

User Manual for ImageAccel 4 OS/2 Control Panel

file:///C|/WINDOWS/Desktop/New Folder/manuals/os2_inst.htm (5 of 10) [2/7/2001 11:55:15 PM]



NOTE: A number of common commercially-available applications do not operate correctly at Logical DPI's above 120. If problems occur, use the ImageAccel
Control Panel to change the Logical DPI to 120 or below.

Top

Windows Options

These settings apply to WIN-OS/2 Full Screen and WIN-OS/2 Seamless environments only. Where indicated Full Screen only, that feature is not available for
WIN-OS/2 Seamless.

Full-Screen and Seamless Windows
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System Font: the choices are:

Standard (default)●   

Large●   

Full-Screen Windows only

Cursor Color:

Allows you to select the color of the WIN-OS/2 Full Screen cursor. The choices are:

Black White

Dark Red Light Red

Dark Green Light Green

Dark Yellow Light Yellow (default)

Dark Blue Light Blue

Dark Magenta Light Magenta

Dark Cyan Light Cyan

Dark Gray Light Gray

NOTE: The WIN-OS/2 Seamless cursor color is white. The PMSHELL cursor color is black. These cursor colors are not changeable to any other color. This is
an OS/2 limitation.

Top

Zoom and Pan Notebook Page

The ability to Zoom in on an image is important for any application that requires manipulation or analysis of highly detailed images. For example, signature
verification on scanned document images or detailed pixel editing for graphics applications benefit from zooming capabilities.

ImageAccel's zoom features allow you to zoom in to any of the available zoom levels and back again with a single hot key. These hardware assisted zoom
features work in combination with any software zooms provided by your application.

The Select Hot Keys notebook page, shown on the following page, configures user-definable keys for ImageAccel's Zooming and Panning features. For OS/2,
the default for each Hot Key is Disabled. Select the Enable option to activate each Hot Key. You may use the pre-defined keys, or choose to define your own
key sequences.
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Zoom In:

Each time you press the Zoom In Hot Key, the screen enlarges the image by one step. At each level the screen blanks then positions itself so that the cursor is
approximately in the center of the zoomed display area.

Zoom Out:

Each time you press the Zoom Out Hot Key, the screen shrinks the image by one step. At each level the screen blanks then positions itself so that the cursor is
approximately in the center of the display screen.

NOTE: You cannot zoom out to a resolution greater than the Desktop Size as declared on the ImageAccel Control Panel.

Zoom Restore:

Pressing the Zoom Restore Hot Key while in a zoomed mode restores the display to the selected Viewport size as defined in the ImageAccel Control Panel.
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Pressing the Zoom Restore Hot Key again returns you to the previously viewed zoom level

Pan Lock:

Pressing the Pan Lock Hot Key locks the Viewport at the current position on the Windows Desktop. When locked, moving the mouse to the edge of the screen
does not move the Viewport. Pressing the Pan Lock Hot Key again unlocks the Viewport and allows panning around the Windows Desktop.

Top

Power Save Notebook Page

The Power Save feature is only available with Energy Star compliant Cornerstone displays. These displays are identifiable by the Energy Star logo on the back
of the display. The Energy Star emblem does not represent EPA endorsement of any product or service. The ImageAccel Power Save feature is software that
switches the display to 2 power save modes (lower power consumption) after a user definable time period in which you have not used the keyboard and mouse.
The Power Save feature is compliant with the VESA DPMS standard for power management and enabled by default, if your Cornerstone Display supports this
feature (see Display Users Guide).
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STAND-BY mode is always the first energy saving step. When this occurs, it turns off some internal circuitry of the Display, which causes the Display to go off
(Screen is black).

SUSPEND mode is a second step. It turns off more Display circuitry to further reduce its power consumption. You will see no change in the Display when this
step occurs.

NOTE: The Screen Saver feature in the WIN-OS/2 session can work in conjunction with Power Save feature as a preliminary step. In some cases Power Save is
not compatible with screen savers. In this case, when Power Save is enabled, you should disable the Screen Saver.

Top
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ImageAccel Plugins for Netscape Navigator or Internet
Explorer
The ImageAccel Netscape PlugIns provide you with high-quality image viewing capabilities from your Web browser.

These plugins represent significant advancements in the worlds of the Internet and Intranet. As more companies use the information highway to distribute
documents (such as manuals, job candidate resumes, and competitive marketing information), the ability to distribute highest quality, scanned images of
such documents becomes increasingly important. If the scanned images are not easily readable, they might not be accepted through these networks. The
Netscape PlugIns address this very issue by delivering to the information highway all of ImageAccel features and benefits--including ScaleToGray, JBIG
compression, and brightness and contrast controls.

The PlugIns work with:

Netscape Navigator 2.0 or later●   

Microsoft Internet Explorer 3.0 or later●   

NOTE: The instructions and examples contained in this document assume you are running Netscape Navigator under Windows 95. If you are using some
other combination of operating system software and browser, there is little difference. Important differences are noted where they apply. Please refer to
your respective documentation for the other combinations.

Installing Your Netscape PlugIns

To install your Netscape PlugIns:

1 Start your computer and Windows, if necessary.

2 Insert your ImageAccel Central CDROM in your CDROM drive. Once your drive is ready, the browser application on the CDROM starts automatically
(this is known as autorun). Be patient--it might take a few moments for the browser to appear.

If you do not want to use the autorun feature, or if the feature does not appear to work correctly on your system, see for further instructions.

Once the browser appears, you have several options for how to proceed. The following diagram shows how to go about installing your plug-ins.

3 As shown above, click Applications, then click Install ImageAccel Netscape PlugIn for Windows 95/98/NT.

ImageAccel Central - Netscape Plugins
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Clicking the final link starts the appropriate Setup program. After you clear the introductory dialog box, another dialog box asks where you want to install
the plug-ins.

4 The Destination Directory section shows where the Setup program intends to install your plug-ins. If this location is acceptable to you, click Next;
otherwise, click Browse and this dialog box appears.

When you finish the preceding steps, the Setup program finishes installing your plug-ins.

Using Your Internet Browser PlugIn
The ImageAccel internet browser plug-in has a flexible mechanism access its features.  You can use either menus or icons make your selections.    The
features in the ImageAccel internet browser plugin include "Scale To Gray"; instant change of the brightness and contrast;  image scaling, rotation, mirror
and invert; copy the image to the clipboard; viewing multiple pages of an image file; information of the image file; print an image; and to view an image in
the embedded mode.

The following paragraphs will elaborate the features available in the plug-in.

The "Preferences" Dialog Box

In this dialog box, there are three sets of options related to the forms of menu. The first set, "Menu items" lets you choose which items are to be added in the
menu.

The menu items available are:

Scale To Gray (*)a.  

Brightness/Contrast (*)b.  

Zoom In (*)c.  

Zoom Out (*)d.  

Fit To Window (*)e.  

Pan Windowf.  

Rotate Leftg.  

Rotate Righth.  

Mirrori.  

Invertj.  

Copy To Clipboard (*)k.  

Previous Pagel.  

Next Page.m.  

Image Infon.  

Each of the above items appears in the dialog as a checkbox. If the item is checked, then it will be in the popup menu or the toolbar. Items with (*) are
checked by default.
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The second set is the "Menu forms" which enables you to select whether a popup menu or a toolbar is to be shown on a right-mouse click. The default is to
use the popup menu. The third set has only one item, "Default Menu Settings", which reset the current settings to the default status. The menu settings
would be saved after exit from the plug-in.

There is one action to the image, "scaling". You can select eight different images scales from a list, and you can even choose the exact percentage you want.
The valid scale range is from 5% to 300%.

To get more information about the usage of this dialog, press the "Help" button.

The Toolbar and the Popup Menu:

The toolbar is dockable to any side of the window, it can also be floating in any place within the image window.

If the image window is too small to accommodate the toolbar in full width or height, the toolbar will be automatically wrap-around to fit the width or length
of the window.

In the popup menu, items listed above are organized into different functional groups as illustrated in the following figure.

The status of the image which is associated with a menu action can be shown in the popup menu or the toolbar, which are "Scale To Gray", "Mirror" and
"Invert". If these actions are applied to the image, the corresponding items in the popup menu will display a check, and the toolbar button will be down.
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Scale To Gray

"Scale To Gray" is one of the most important features of ImageAccel.  It’s an algorithm to display a bitonal TIFF image as a grayscale image so that
the image has an optimum viewing effect. It’s only applicable when the scale factor is less than 1:1.

●   

Instant Brightness/Contrast

If it is activated, the "Brightness & Contrast" dialog will pop up. If "ImageAccel Control Center " is not running at this moment, it will be launched

●   
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first.

"Zoom", "Fit To Window" and the "Pan Window"

You can either use the "Zoom In" or "Zoom Out" in the popup menu/toolbar, or use the "Scaling" in the "Preferences" dialog to change scale of the
image. Also, you can use "Fit To Window" to scaled the image to the size of the display window. When the image is too big to fit into the window,
you can use the "Pan Window" to browse different parts of the image.

When the Netscape window is resized, the image display is changed accordingly. If the image size is using the "Fit To Window" option before
resizing, then the image will be scaled to fit to the new size of the window also; otherwise, the scale of the image will be unchanged, while the display
area of the image and the status of the scroll bars may be changed accordingly.

●   

Image Rotation, the Mirror and the Invert function

Using rotation, the image can be rotated 90 degrees clockwise or counter-clockwise. Using mirror function, the image can be viewed in a mirror
reflection. The image is mirrored along the left or right side of the image edge and vertical to the screen. The "Invert" function inverts all the color
information of the image, making a negative image.

●   

Copy To Clipboard

The whole image or part of it can be copied to the clipboard. If the left mouse is used to select a rectangle within the image area, then the part of
image in the rectangle is selected; otherwise, if the left mouse is clicked without selecting a rectangle, then the whole image is selected. The selected
part of image will be copied to the clipboard once the "Copy to clipboard" menu/button is clicked.

If the image has been rotated, the part of image in the rectangle still can be copied, but it would be always in the original orientation.

If an image rectangle is selected and then a rotation is performed, the selected rectangle will also be rotated accordingly, and the selected part of
image will remain unchanged.

●   

Previous/Next Page

These items let you browse different pages of an image file. They are applicable only to the multiple-paged TIFF files.

●   

Image Info

It shows the information about the image. The information would be changed in real time on some actions, e.g., rotation, page up/down.

●   
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Printing the image

You can print the image by selecting the Navigator’s "Print" menu/toolbar (not the plug-in’s menu/toolbar). The image is printed in a full page.

●   

Embedded plug-in

For an image opened in an embedded plug-in, it only takes part of the Netscape window. If the user double click the image with the left mouse button,
the image will be displayed in a full-page mode. In this full-page mode, neither the popup menu nor the toolbar can be displayed, but all of the actions
can still be accessed by using the hot keys. When the user double click the image again, it will go back to the previous embedded mode.

●   
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PixView Demo User Manual
PixView Demo is a demonstration version of the PixView application. PixView is an Input Software Inc.  Pixel Translations product.

PixView is an image acquisition environment for scanning, viewing, printing, and saving images.●   

Certain features have been disabled in this demonstration version of PixView:●   

Scanning functions are disabled.●   

The demonstration version works only if you have an ImageAccel display controller installed. ●   

PixView Demo shows ways you can implement some of the features provided in our toolkit products; such as PixTools/Scan and PixTools/Display & Print.

**Attention ImageAccel customers:  Under certain situations, a expiration notice will result upon loading this application.  If this happens to you, please
contact your Cornerstone representative for the latest copy.**  

This document contains the following information:

About the PixView Demo●   

Introduction●   

Running PVDemo●   

Viewing Images with PVDemo●   

Other Viewing Options●   

Using Annotation Tools●   

Specifying Page Settings●   

Specifying Application Settings●   

Printing Images●   

Saving Images●   

Using the PixTools/View Setup Control Panel●   

PixLoaded95 and PixUnload●   
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About the PixView Demo
To run PixView Demo (hereafter called "PVDemo"), you need the following:

386SX or better computer●   

4 MB RAM (8 MB recommended)●   

2 MB hard disk space●   

VGA or better display●   

Mouse or other pointing device●   

Windows 95, 98 or NT 4.0.●   

You do not need a scanner to run PVDemo. You can display images directly from disk.

PVDemo uses ISIS™ libraries (Image and Scanner Interface Specification) to support scanners. The fully functional PixView application allows full control
of scanner parameters and supports scanners with dedicated controllers, SCSI, and video-based scanner interfaces, such as those from Kofax and Xionics.

PVDemo provides a high-performance viewer with fast scaling, fast rotation, background image pre-loading, scale-to-gray conversion, image annotations, and
a Pan window. PVDemo supports ImageAccel display controller cards from Cornerstone Imaging.

PVDemo supports black and white as well as gray scale images. It also supports viewing, printing, and saving.

PVDemo prints images with features such Fit Page, Actual Pixels, Actual Size, and Thumbnails.

PVDemo stores images in many popular image file formats and compression schemes, according to the capabilities of the selected file format. The following
table shows the supported file formats and compression schemes.

Image File Formats Compression Schemes
TIFF CAL

PCX/DCX CMP

BMP DCX

PDA MDA

JBIG PCX

FAX PDA

MODCA T64

Top
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Installing PVDemo
Insert your ImageAccel Central CDROM in your CDROM drive. Once your drive is ready, the browser application on the CDROM starts automatically (this
is known as autorun). Be patient--it might take a few moments for the browser to appear.

Then, click Application, then click Install ImageAccel Windows 95/NT demo program PVDEMO.

Clicking the final link starts the appropriate Setup program.

After the introductory dialog boxes appear, indicate where you want to install PVDemo (that is, the disk and directory). You can also indicate whether or not
you want to include PVDemo items in your Windows Start menu (which is recommended).

Setup also displays a dialog box asking if you want to install driver software for your scanner. This demonstration version of PixView does not support
scanning, so you should ignore this message.

At the conclusion of the Setup program, you are ready to run PVDemo.

As the preceding illustration shows, Setup installs items on your system that show up in your Windows Start menu. The Setup program also installs sample
image files on your hard disk that you can use with PVDemo.

Top

Running PVDemo

To start PVDemo:

Display the Windows Start menu, highlight the PixView Demo Windows folder, the locate and select the PixView Demo item. The PVDemo window
appears on your screen.
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Viewing Images
With PVDemo you can view several different types of images. This section explains how to view the sample images that come with PVDemo. It also explains
how to view other images.

Testing PVDemo Flip Speed

The sample images included with PVDemo give you some idea of the extreme speed with which PixView displays images, and the superb image quality
available with the PixView application.

All illustrations of buttons shown in this document appear with the Display Toolbar Text option deselected. The buttons might not look the same when you run
PVDemo. See Application Settings.

To test image flip speed:

Display the Demo menu and choose Load Images (or pressCtrl+D). There is a slight delay while PVDemo loads the series of image files into memory. Once
loaded, the first page in the series appears in the PVDemo window.

Click the Loop Demo button.

All of the images in the series appear rapidly in succession. PVDemo continues to loop through the images repeatedly.

When you are ready to stop looping, choose Stop Demo from the Demo menu (or press Ctrl+S).

When you stop the demo, the Image Flip Time dialog box appears (you can also display this dialog box by choosing Show Timing from the Demo menu).
The graph in this dialog box shows the time required to read each file, the time required to decompress each file, and the time required to display each file (for
as many as 8 images).

Opening Other Images

You can open any of the file types listed at the beginning of this section into your PVDemo window.

To open other images:

Choose Open Document from the File menu. The Open Document dialog box appears.
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You can use this dialog box to open a single file, or open several files as a batch.

Select a file to open in the File Name list, then click Select.

To open multiple files, repeat the preceding step for each one you want to open. Each file you select appears in the Selected Files list.

If you want to open all files in the current directory, click Select All.

To remove a file from the Selected Files list, select it, then click Remove.

When the Selected Files list contains all of the image files you want to open, click OK. The first image in the list then appears in your PVDemo window.

If you opened a batch of files, you can:

Use the steps outlined under Testing PVDemo Flip Speed to quickly flip through the images; or,
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Click the Prev Page and Next Page buttons to browse through the images one-by-one.

Top

Other Viewing Options
This section discusses other options for viewing images with PVDemo.

Scaling the View

Use the buttons in the toolbar to set your view of the image in the PVDemo window to whatever suits you.

Rotating the View

Click the Rotate button in the toolbar to rotate the page in 90·, clockwise increments.

Navigating Pages

Use the Prev Page and Next Page buttons to browse through pages one-by-one. To go to a specific page in a document or batch series, choose Goto Page
from the Page menu and enter the number of the page you want to view.

The Page menu also contains the Show Thumbnails item. See Viewing Thumbnails.

Using the Pan Window

The Pan Window shows a miniature version of the entire page, with that portion of the page in the main window shown in reverse video.
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To use the Pan Window:

Choose Pan Window from the Window menu.

Point to the reversed video area in the Pan Window, then click and hold the mouse button.

Drag the reversed area around and watch the image in the main window move. When you have positioned the image where you want it, release the mouse
button.

Viewing Thumbnails

You can view files (documents or pages) as thumbnails--that is, miniature versions of a document or pages.

To view thumbnails:

Choose Show Thumbnails from the Page menu.

When the Thumbnail Setup dialog box appears, select the arrangement you want in the Thumbs list, then click OK. The Document Pages window appears.
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Viewing Image Information

Additional information about your pages and documents is available by choosing About Image from the Help menu.
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To see even more information, click the More button.
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Windows Clipboard Support

PVDemo supports copying to the Windows Clipboard, but not pasting from the Clipboard.

To copy all or part of an image:

To copy all of the image in the current window, do not select any area.

To copy only a part of the image, drag a rectangle over the area you want to copy.

Choose Copy from the Edit menu.

Once the data is on the Clipboard, you can paste it into any application that supports image pasting.

Top

Using Annotation Tools
Annotation tools provide a way for you to add information to your pages. You can add information as simple text, popup text, highlights, lines and
arrowheads, and more.

In order to use the annotation tools, you need to display the Annotation Toolbar in your PVDemo window. To display the toolbar, choose Application
Settings from the Options menu, then select the Display Annotation Toolbar option.

All of the annotation tools have individual option settings; such as font, color, line width, and so forth. You can specify the options you want to use in
conjunction with each tool before using it. To specify your options, display the Annotations menu, highlight the tool you want to access, then choose an
option from the submenu that appears.

Most of the annotation tools work in the same manner, as explained in the following steps:

Click the button for the tool you want to use in the Annotation Toolbar.

Move the cursor inside the PVDemo window workspace. The cursor changes into a shape that shows you what type of annotation you are about to add.

For the Text, Popup Text, or Stamp tools, click where you want to insert the annotation. (More information about the Stamp tool appears later in this
section.)

For any of the remaining tools, drag to create the annotation. For example, when you drag the Highlight tool you create a rectangle on the page with the
chosen color and transparent or opaque property.

Use the Select tool to select any existing annotation object on the page. You can then move or delete the selected object (to delete the object, press the Delete
key). In the case of Highlight, Redact, Line, Arrow, and Box objects, resizing handles appear so that you can change the size of the object.

Use the Stamp tool to stamp an image (such as a bitmap file) onto your page. You can specify the file you want to use as your stamp by choosing the tool in
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the Annotations menu, then choosing the File option. If you use the Stamp tool but have not yet chosen a file to use as your stamp, a file selector dialog box
appears so that you can select the file. If you have already chosen the file you want to use, the image appears on your page when you click with the Stamp
tool.

Top

Page Settings
This feature provides settings that can affect either the current page or all pages in the document, depending on the state of the All Pages check box. To access
these features, choose Page Settings from the Options menu to display the following dialog box.

In addition to Rotation, Scaling, and Scale to Gray, the Page Settings dialog box offers the following options:

Mirror--Produces a mirror-image of the original image.

Invert--Produces a negative image of the original.

Brightness and Contrast--Available only if you select the Scale to Gray option.

Horz Pres and Vert Pres--Available when viewing black and white images that are not scaled to gray. These sliders change the threshold at which horizontal
or vertical pixels are preserved in images that are displayed at less than 1:1 scale. You can often improve readability with these sliders.

All Pages--When selected, any action in this dialog box affects all pages in the document. When not selected, actions affect only the current page.
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Instant Update--When selected, changes made in the dialog box take effect immediately. When not selected, changes are applied only when you close the
dialog box.

Color--Extends the dialog box to include settings for changing the color balance of color images.

Top

Application Settings
Application settings affect the way PVDemo operates. Choose Application Settings from the Options menu to display the following dialog box.

Pan Window Section

Display Window--Displays or hides the Pan window.

Use Scale to Gray--Uses scale-to-gray to improve readability.

Display Features Section
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Display Toolbar--Displays or hides the main toolbar.

Display Annotation Toolbar--Displays or hides the annotation toolbar. See Using Annotation Tools for details.

Display Toolbar Text--Adds text descriptions to each tool. Deselecting this option decreases the size of the toolbar or toolbars, thus giving you more room in
your PVDemo workspace.

Display while scan--Displays images while scanning (slow scanners).

Disable Accelerator--Enables or disables the ImageAccel display controller, if present. Disabling this option degrades performance of ScaleToGray functions.

Scan Features Section

Auto Resume Scan--Automatically resumes scanning when your scanner's document feeder is reloaded.

Zoom Factor Section

Specifies the amount of zooming when using the zoom tools.

Color Features Section

When selected, PixView dithers all High Color and TrueColor images to 256 colors.

Top

Printing Images
PVDemo provides you with a variety of printing options, as explained in this section.

To print images or parts of images:

To print only a selected area of one or more pages, define the selection by dragging a rectangle over the area you want to print.

To print entire pages, do not select anything.

Display the File menu, highlight Print Page(s), then select one of the following options from the submenu:

Print (Fit Page)--Prints each page so that the image fills the printer's page size.

Print (Actual Pixels)--Prints each page using one printer pixel for each pixel in the image.

Print (Actual Size)--Prints the image actual size, which may result in cropping on printers that cannot print to the very edge of the paper.

Print Thumbnails--Prints a user-specified number of page images on each page, and optionally prints borders and filenames for each image.

After choosing one of the preceding print options, the standard Windows Print dialog box appears. Specify the page range you want to print. If you selected an
area in step 1, select the Selection option.

Click OK to begin printing.
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Top

Saving

To save a page:

To save a selected area of one or more pages, drag a rectangle over the area to select it.

To save the entire image of each page, do not select anything.

Choose Save page as or Save document as from the File menu. The following dialog box appears.
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Select the options you want used when saving the page, then click OK.

Top

PixTools/View Setup Control Panel
The PixTools Control Panel did install when I ran setup. However, I am not able to open the panel due to a missing DLL.

PVDemo provides a control that you can use to control hardware-accelerated image printing and display.

To use the control panel:

Display the Windows 95 Start menu, highlight Settings, then choose Control Panel. The Control Panel window appears on your screen.

Locate the PixTools icon in the window, then double-click it to open the PixTools/View Setup panel.
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To enable or disable accelerated printing, select your printer in the Printer and connection list, then click Set Accelerator.

In the list of accelerators that appears, select your printer accelerator, then click OK.

To enable or disable accelerated image display, select or deselect, respectively, the Use display accelerator option.

You can, if desired, specify a Number of pages to cache above or below the default of 5. Increasing the cache normally improves performance when
displaying images that have already been displayed, provided the cache has not been overwritten by other images.

If you have problems with accelerated image display, try deselecting the Use device-dependent bitmaps (DDB) option.
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PixView Settings
PixView always remembers your latest program settings, such as window position, application and page settings, and more. When you restart PixView, the
program uses all of your most recent settings.

Top

PixLoaded95 and PixUnload
PixLoaded95 shows all currently running application and system modules in Windows 95. Use for system troubleshooting when conflicts occur.

PixLoaded95 Example:
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PixUnload

PixUnload is used when a PixView Demo conflict occurs, or when the system becomes unstable. If these conditions occur when PixView is running, simple
exit (close) PixView, and the run the PixUnload application. Any remanants left over from the conflict will be cleared from memory, and you may re-launch
PixView again without rebooting.

Top

ImageAccel Central User Manual - PixView Demo

file:///C|/WINDOWS/Desktop/New Folder/manuals/m95_pvdm.htm (18 of 18) [2/7/2001 11:55:33 PM]



 

Cornerstone Image Viewer
The Cornerstone image viewer provides you an application for high-quality image viewing, allowing you to take advantage of our controllers capabilities
--including ScaleToGray, and brightness and contrast controls..  It also provides the capability of high-quality image viewing in Microsoft Word, Excel or
other OLE enabled application after the user inserting a TIFF file and activating the viewer. The viewer works on Windows 95(98) and Windows NT
4.00(or above).

 

Installing Your Cornerstone Image Viewer

To install your Cornerstone Image Viewer:

1 Start your computer and Windows, if necessary.

2 Insert your ImageAccel Central CD-ROM in your CD-ROM drive. Once your drive is ready, the browser application on the CD-ROM starts automatically
(this is known as autorun). Be patient--it might take a few moments for the browser to appear.

If you do not want to use the autorun feature, or if the feature does not appear to work correctly on your system, see for further instructions.

Once the browser appears, you have several options for how to proceed. The following diagram shows how to go about installing your plug-ins.

3 As shown above, click Applications, then click Install Cornerstone Image Viewer(Beta).

Clicking the final link starts the appropriate Setup program. After you clear the introductory dialog box, another dialog box asks where you want to install
the viewer.

4 The Destination Directory section shows where the Setup program intends to install your viewer. If this location is acceptable to you, click Next;
otherwise, click Browse and this dialog box appears.

When you finish the preceding steps, the Setup program finishes installing your Cornerstone image viewer.

Note:  In order to be able to embed the Image Viewer into a container, such as Microsoft Word / Excel, you need to run the Cornerstone Image Viewer stand
along once.
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Using Your Cornerstone Image Viewer
The Cornerstone image viewer has a flexible mechanism access its features.  You can use either menus or icons make your selections.    The features in the
Cornerstone image viewer includes image scaling, rotation, invert; navigation in a multiple page image file; copy or cut the selected part of the image to the
clipboard, and paste an image from the clipboard; viewing multiple pages of an image file;  print an image; and a little demo just to show off the imaging
capabilities.

The following paragraphs will elaborate the features available in the viewer.

 

The Menu, the Toolbar and the Popup Menu:

The toolbar is dockable to any side of the window, it can also be floating in any place within the image window.

If the image window is too small to accommodate the toolbar in full width or height, the toolbar will be automatically wrap-around to fit the width or length
of the window.

Some of the functionality can be access through popup menu, which is activated by clicking at the right button of you mouse.  In the popup menu, items
listed above are organized into different functional groups.

 

File

You can open and save files, print a page of image by using this menu.

●   

Edit

The whole image or part of it can be copied or cut to the clipboard. If the left mouse is used to select a rectangle within the image area, then the part
of image in the rectangle is selected; otherwise, if the left mouse is clicked without selecting a rectangle, then the whole image is selected. The
selected part of image will be copied to the clipboard once the "Copy to clipboard" menu/button is clicked.

To Select part of the image, you can use "Select" under the "Edit" menu or click on the "Select" icon (which looks like a little rectangle.)

The content that pasted from the clipboard is inserted onto the picture at its upper left corner.  After pasting, you can move the pasted content
anywhere in the image.

●   

Page

The items in the submenu or the popup menu let you browse different pages of an image file and do image rotation. The multi-page functionality are
applicable only to the multiple-paged TIFF files. Using rotation, the image can be rotated 90 degrees clockwise or counter-clockwise.

●   

Zoom

You can either use the "Zoom In" or "Zoom Out" in the menu/toolbar, or use "Zoom to Selection" to zoom in an area you have selected, or use "Zoom
to Height" or "Zoom to Width" to zoom to the height or width of the current window to change scale of the image.  Furthermore, you can zoom to a
specific scale factor by using the preset zooming factor such as "25%", "50%", etc under the "Zoom" submenu, and you can even name any odd scale
factor by specifying in the "Custom..." under the "Zoom" submenu. Also, you can use "Fit To Window" to scaled the image to the size of the display

●   
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window.

When the viewer window is resized, the image display is changed accordingly. If the image size is using the "Fit To Window", "Zoom to Width" or
"Zoom to Height" option before resizing, then the image will be scaled to fit to the new size of the window also; otherwise, the scale of the image will
be unchanged, while the display area of the image and the status of the scroll bars may be changed accordingly.

Demo

This is only a little demo.  You first load the demo images by using "Load Images", then you use "Loop images" to see the demo, which will show
you the timing for each image, and you can always get the demo timing by clicking at the "Timing" again after you have loop the images at least
once.

●   

 

Activating Cornerstone Image Viewer inside Microsoft Word:

In Microsoft Word, under "Insert" menu, click on "Object..." submenu.  A Dialog box will pop up.  Choose the "Create from file" tab, and then insert a TIFF
file.  After that, double click at the image you just inserted, the Cornerstone image viewer will be in-place activated in Microsoft Word.

For other OLE client, find the similar method to insert a TIFF file, and then double click on it to activate.
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